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No one's too young...
No one's too old...

for Kid Pix!

All kids are artists. Give them a box of crayons or a set of finger
paints and they plunge right in, not worried about making messes
or doing things “right.” For them, art and play are inseparable;
the process is as important as the result. Now at last, there’s a
program that takes advantage of kids’ natural creative impulses
and lets them use the computer in a playful way to create art
that’s uniquely their own.

Kid Pix is a paint program designed just for kids. It was

created by a dad — Craig Hickman — for his three-year-old son
Ben. Craig discovered how much Ben loved to create art with the
computer when he introduced him to a full-featured paint
program. But he also discovered that with the “big” program,
Ben often got himself into frustrating situations. He accidentally
launched desk accessories, moved windows, and made random
menu selections. Craig decided to solve these problems by
writing a paint program just for kids.

Special
Features:

Brederbund’s Kid Pix is a much-expanded and enhanced version
of Craig Hickman’s original program. It’s loaded with fun
features — everything from crazy sound effects and patterns that
burst into color to brushes that paint in wacky ways and mystery
tools that yield surprising results. Yet it still retains all the
natural, easy-to-use and kid-proof features that Craig, responding
to his experiences with his own son, built into the program.
These features include:

* A Small Kids Mode that allows you to turn off the menu bar so
that young children can’t open menus and make selections
accidentally.

* A drawing area that’s visible all at once on the screen. No



scroll bars needed to maneuver the picture. What you see is
what you get when you print out.

¢ Tools and tool options that are available right on the screen.
No menus to open, no dialog boxes to confuse. The tools
themselves perform with a minimum of fuss, and the options that
go with them are new and exciting.

e Text and numbers that can be added to pictures without using
the keyboard. The program speaks the names of letters and
numbers out loud as they’re selected. You can even choose to
have them spoken in Spanish.

e Sound and visual effects that add fun while they stimulate
creativity and reinforce learning for kids.

And what about you, the grown-up reading these words? Can
you enjoy Kid Pix, too? You bet! It’s a fully-faceted paint
program. You’ll have fun using it with your kids. Then, after
they’re tucked away safely in bed, turn on the computer and play
with it all by yourself. As we discovered from hearing the
whoops of delight issued by the computer-savvy folks at
Broderbund who tested this product, no one’s too old or too
sophisticated for Kid Pix!

About this
Manual:

Kid Pix was designed so that kids who aren’t old enough to read
can use it. That means you don’t really need to study this
manual to operate the program. In fact, lots of the fun with

Kid Pix comes from discovering for yourself what the tools and
their options do. This manual can serve as a handy map for your
explorations. It shows the general lay of the land, highlights
points of interest you might miss, and rescues you if you get lost.
There are five main sections:

Getting Started tells you how to start the program, and fills you
in on technical details.

Working With Kid Pix gives you an overview of the program. It
tells you, quickly and simply, everything you need to know to use
Kid Pix.

About Kid Pix Tools explains how each drawing and special
effect tool works.

About Kid Pix Menus describes each feature of the Kid Pix
menus.









Getting
Started

What you'll e Kid Pix User’s Guide.
find in this
package: * Two Kid Pix disks:
Disk 1, Program
Disk 2, Bonus Sounds
e Kid Pix stickers
What you Required
will need:

® Macintosh with two 800K disk drives

* 1 Mb RAM for monochrome systems, 9" monitors; 2 Mb
RAM for color systems

* With System 7.0, 2 Mb RAM for monochrome systems; 4Mb
RAM for color systems

Nice to have
e Hard Disk

® Monochrome or Color Printer

Optional

® The Farallon™ MacRecorder®



Starting the
Program:

Two disk drive system:

To run Kid Pix on a system with two 800k drives, you must
first put Kid Pix on a "diet". Putting Kid Pix on a diet
removes all of the program's color capabilities that aren't
needed on a monochrome system. This reduces the size of the
program so that both Kid Pix and one of the Alphabet files can
fit on the same 800k disk.

You must also create a start-up disk that contains a System
folder, printer driver, MacRecorder driver (if you have a
MacRecorder) and the Kid Pix Sounds file.

For simple, step-by-step instructions on how to put Kid Pix on
a diet, please turn to page 43 of this guide.

Hard disk system:

1. If this is the first time Kid Pix is being used, you need to copy
it to your hard disk. To copy:

1) Create a folder on your hard disk called "Kid Pix".

2) Copy the program from Disk 1 into the folder on your hard
disk.

3) Copy "Sounds," the "English Alphabet" and "Alfabeto en
Espariol" (Spanish Alphabet) from Disk 2 into the Kid Pix
folder on your hard disk.

2. To use Kid Pix:

1) Double-click on the Kid Pix program icon.

Monochrome systems with Multifinder or System 7.0

If you get a message that says "The application 'Kid Pix' could
not be opened . . ." refer to page 42 of this manual for
instructions on resetting the Application Memory Size to 800k.

If you get a message that says "Do you want to open it using
available memory?," click "OK" and Kid Pix will guide you
through the process of resetting the Application Memory Size.










Working
with
Kid Pix

Starting the Kid Pix program is like entering your very own
artist’s studio. Everything you need is at hand — brushes, paints,
pencils, erasers, interesting bits of this and that. Nothing is
difficult to use. A three-year-old can create a wonderful drawing.
An eighty-year-old can, too. And everyone has fun in the
process.

The best way to start using Kid Pix is to plunge right in. There’s
no “right” way to do things, no correct sequence to follow. You
can’t make a mistake, because there are no mistakes to be made.

This section of the manual and the sections on tools and menus
that follow will tell you everything you need to know to use
Kid Pix. Read them through before beginning, if that’s your
style. Or simply refer to them if you get stuck.

The Kid Pix
Drawing
Screen:

The Kid Pix Drawing Screen appears when you start the
program. The drawing area is like a blank sheet of paper. You
draw on it by first selecting a tool and tool options, then holding
the mouse button down and moving the mouse. Nothing is
hidden from view. When you print out your drawing, everything
you see in the drawing area will appear on the printed page.




The Kid Pix Drawing Screen

Menu Bar —|

TOOLS & File Edit Goodies

Wacky Pencil
Line
Rectangle
Oval

Wacky Brush
Electric Mixer
Paint Can
Eraser

Text

Rubber Stamps

Moving Van
The Undo Guy

Current Color

Color Palette

Tool Options ‘—l

10



Menus

Menus are contained on the menu bar at the top of the screen.
They let you perform various functions, such as editing, saving
and printing your work. The Goodies menu provides access to
special features of the Kid Pix program.

* To open a menu and choose a command, point to the menu
you want and press the mouse button. Move the pointer down
the menu to the command you want, then release the button.

Tools

Kid Pix drawing tools are at the left of the screen. Each tool has
its own set of options which are displayed at the bottom of the
screen. The pointer will change shape, depending on the tool
selected.

* To select a tool, simply point to the tool you want and click the
mouse button. The selected tool will be highlighted and its
options displayed.

Tool
Options

The tool options at the bottom of the screen change, depending
on the tool selected. The options vary the basic behavior of the
tool. They control such things as line width and pattern, let you
draw in a variety of styles, and erase in different ways. The tool
options are one of the most appealing things about Kid Pix.
You’ll have fun playing with them even if you’re not trying to
create a finished drawing.

* To select a tool option point to the one you want and click the
mouse button. The selected option will be highlighted.

A at the end of a set of options indicates that more are
available. Click E'% to see more.

Color

Kid Pix takes advantage of the full range of color available on
your Macintosh system. If you are using a color system, a color
palette will appear at the left of the screen beneath the tools. If
you are using a monochrome system, the color palette will not
appear.

The current color is displayed in a box at the top of the palette.
This is the color the selected tool will use to draw. You can select
a new current color whenever you want. Some tool options
produce multi-colored effects. 11



¢ To select a current color, point to the color you want and click
the mouse button. The selected color will appear in the current
color box.

You can extend your range of color choices by selecting colors
from the Apple Color Picker.

e To use the Apple Color Picker, hold down the Option key while
clicking on the current color. The Color Picker will appear.

Click the color you want. The color you’ve selected will appear
in the current color box. (Note: Colors chosen from the Apple
Color Picker will not replace the colors in the Kid Pix palette.)

Select new color.

119

o]

Hue |32768
Saturation |39322
Brightness |65535

EN

Red |26214
Green | 65535
Blue | 65535

21
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Sound

Kid Pix has a dazzling array of sound effects. Paint gurgles as it
pours. Letters speak their names, firecrackers explode, pictures
and symbols fall into place with a satisfying click. If you are
using a system with a microphone, you can even record spoken
messages to accompany your creations.

Kid Pix tool sounds are designed to stimulate creativity and
reinforce learning. But sometimes a little peace and quiet is in
order. You can adjust the sound volume by using your
Macintosh control panel or you can turn off tool sounds entirely.

* To turn off tool sounds, simply choose “Tool Sounds™ from the
Goodies menu. To turn them back on, choose “Tool Sounds”
again.

e To record a spoken message, choose “Record™ from the
Goodies menu; to play back a recorded message, choose “Play.”
For complete details on recording and playing back messages, see
Goodies menu, page 37-38.

Small
Kids
Mode

12

Small Kids Mode is a very useful feature of Kid Pix. When it’s in
effect, the full menu bar at the top of the screen disappears so
there’s no chance of opening a menu and choosing an item



accidentally. If you are using a system with Multifinder, a “bib”
is put around the screen so that the user cannot accidentally open
a background application.

You’ll probably want to use Small Kids Mode whenever younger
children are working with the program. It’s a simple way of
preventing them from getting stuck in situations they don’t know
how to handle, and of protecting other applications on your
system.

Note: You cannot open or save a file or quit while you are using
Small Kids Mode. You will need to turn off Small Kids Mode
before you can perform any of these functions.

* To turn on Small Kids Mode, simply choose “Small Kids
Mode” from the Goodies menu. The full menu bar will be
replaced by a short Kid Pix menu.

* To temporarily view and select items from the full menu bar,
choose “Show Menu Bar.” The full menu bar will disappear
when drawing is resumed.

® To turn off Small Kids Mode, choose “Show Menu Bar” from
the Kid Pix menu. Then open the Goodies menu and choose
“Small Kids Mode” again.

Saving and
Retrieving
Drawings

You can save Kid Pix drawings and then retrieve them to print
out or work on again. Don’t worry about losing your creations.
Kid Pix always gives you a chance to save before you start a new
drawing or quit the program. Kid Pix will save your drawings in
the PICT format.

Note: If Small Kids Mode is turned on, you’ll need to turn it off
before you can save or retrieve a drawing,.

* To save a drawing, choose “Save” from the File menu. Type in
a name for your drawing, then click OK. You can save any
changes you make to the drawing by simply choosing “Save”
again. It’s a good idea to save your work periodically to guard
against loss due to system or power failure.

* To save a previously named drawing under a different name,
choose “Save As . ..” from the File menu. Type in a new name
for the drawing, then click OK. The drawing will be saved under
its new name; the original drawing will remain saved under the
original name. 13



* Sounds you have recorded with your microphone or
MacRecorder will be automatically saved with your drawing. To
save a drawing without it's recorded sound, click in the "Save
with Sound" box to deselect this option. Pictures saved without
recorded sounds require less disk space.

* To retrieve a saved drawing, choose “Open” from the File
menu. Select the drawing you want from the list that appears on
the screen.

® Pictures saved with recorded sounds will automatically play the
sounds upon opening. To open without sound playing, click in
the "open with sound" box to deselect that option.

Starting
a New
Drawing

You can start a new drawing whenever you want. It’s as easy as
flipping to a clean page in a drawing pad.

e To start a new drawing, choose “New” from the File menu.
You’ll be given a chance to save changes made to the current
drawing. Then the area will be cleared and you’re ready to start
drawing again. Note: If Small Kids Mode is turned on, you’ll
need to turn it off before you can start a new drawing by
choosing “New.”

e If you don’t care about saving your drawing, you can start a
new drawing simply by erasing the screen using one of the eraser
tools.

Importing
Pictures:

14

You can import a wide variety of computer-generated images —
everything from clip art, digitized photos, Print Shop graphics, or
pictures you’ve created with other paint programs — to use in
your Kid Pix creations. You can do this either by using the
Scrapbook desk accessory or by simply opening any graphics file
stored as PICT, a common Macintosh graphics file format.

Note: For complete information on storing images in the
Scrapbook, see your Macintosh manual.

* To import a picture stored in the Scrapbook:

Open the g menu and choose “Scrapbook.” Select a stored
image by clicking the scroll arrows until the image you want
appears on the screen.

Open the Edit menu and choose “Copy.” The image you



selected from the Scrapbook will be copied to the Clipboard.
Close the Scrapbook by clicking the square in the upper left
corner.

Choose “Paste” from the Edit menu. The image from the
Clipboard will appear on your Kid Pix drawing. Move the
mouse without pressing the mouse button to position the image.
When it is where you want it to be, click the mouse button to
paste it in place.

e To import a picture stored in the PICT file format, choose
“Open” from the File menu. Select the picture you want from
the list that appears on the screen. A warning will appear to
remind you to rename your PICT file before saving changes
made in Kid Pix.

Note: Some cropping of the PICT picture may occur so that it
will fit in the Kid Pix drawing screen.

Printing

Everything you create with Kid Pix can be printed out. If you
have a color system and color printer you can print your drawing
in color.

Before attempting to print, be sure that your printer is connected
properly to your computer. Check print specifications by
choosing “Page Setup . . .” from the File menu. Remember to
select "ImageWriter with Color Ribbon?" if printing from an
ImageWriter with a color ribbon installed.

e To print, choose “Print” from the File menu.

Select print quality and specify the number of copies you want.
You can print a small version of your drawing by selecting “50%
reduction.”

For faster printing from your LaserWriter and LaserWriter driver
6.0.2 or 7.0, choose "Black & White" instead of "Color/
Grayscale".

Quitting the
Program

When you’re done using Kid Pix, leave the program in an orderly
way by quitting, rather than just shutting off your computer.
Kid Pix will give you a chance to save any work you have done.

Note: If Small Kids Mode is turned on, you’ll need to turn it off
before you can quit the program.

15







About
Kid Pix
Tools

Kid Pix tools come with a wide variety of options that are
displayed at the bottom of the screen whenever a tool is selected.
Some tools have several sets of options. A icon at the end of
a set indicates that more options are available. Some tools and
tool options behave differently if you press the Option key
during use. These are marked here with a star (%). Experiment
to find out what they do.

¢ To select a tool, point to the one you want and click the mouse
button.

e To select a tool option, point to the one you want and click the
mouse button.

* To see more tool options, click the §'% i

Wacky
Pencil

@ Wacky Pencil

The Wacky Pencil draws free-form lines. Select line widths, line

styles, and line patterns from the Options bar. The || option

produces a tint effect, like a water color wash, that’s great for

coloring Kid Pix “hidden pictures.” If you are using a

monochrome system, the [i option produces a half-tone
effect. The option cycles through a color palette while it
draws, giving a "rainbow" effect. On monochrome systems, the
brush cycles through a palette of greys. There are two sets of line

options, giving you square or circle-shaped lines.

17
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Line

The line tool draws straight lines. Select line widths and line
patterns from the Options bar. The {'?} option produces a ray
effect that inverts the color of whatever it passes over.

* To draw a perfect horizontal, vertical, or 45 degree angle line,
press the Shift key while using the tool.

Rectanglex

The rectangle tool draws rectangles in various patterns. Select

the pattern you want from the Options bar. For a transparent

rectangle, use the first pattern; for an opaque white rectangle,
. ' ‘ . .

use the third pattern. The option produces a rainbow

rectangle.

® To draw a rectangle without a black border, press the Option
key while using the tool.

e To draw a perfect square, press the Shift key while using the
tool.

e Option + Y| fills a rectangle with shades of gray.
P h‘d

Ovalx

The oval tool draws ovals in various patterns. Select the pattern
you want from the Options bar. For a transparent oval, use the
first pattern; for an opaque white oval, use the third pattern.
The option produces a rainbow circle.

e To draw an oval without a black border, press the Option
key while using the tool.

* To draw a perfect circle, press the Shift key while using the tool.

e Option + fills a circle with shades of gray.

Wacky
Brush

Wacky Brush

The Wacky Brush is lots of fun. It paints in a variety of ways,
depending on the tool option you select. There are two sets of
Wacky Brush tool options. If you are using a color system, most



paint in the current color, but some are multi-colored. For
several, the behavior of the brush changes if you hold down the
Option key while moving the mouse.

Wacky Brush Options

Here’s what the Wacky Brush tool options do. Those marked
with a star (%) change a bit when used with the Option key. Try
them and see.

|; Leaky Penx

Your pen’s sprung a leak. Ink soaks into your “drawing pad”
whenever the pen stops moving.

Ao

Zig-Zagk

Bet you can’t draw a straight line with this one!

). @

Dots*

Lots and lots of dots.

e ®
£ 34

Bubbly*

Soda pop time. Plenty of bubbles and fizz.

“ Pies*

Everyone’s after a bigger slice of the pie.

@) Echoesx

Circles within circles within circles. 19
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Northern Lights

Colorful aurora borealis. Can be horizontal or vertical depending

& on which direction you move the brush.
2
¢ 8
@O {3§Q (2 Fuzzer |
{}ﬁ éf}“ ’ “Fuzzes” whatever it moves over. |
@ o
OF
“iﬁ Magnifying Glass*
O Enlarges whatever is under it. Move it around your drawing like
i@ Sherlock looking for a clue.
O @
& O
S e
'w;e :) .......
fﬁ’ & Spray Paint*
G C Sprays a line of mist.
@ &
O o
iy B &
R O
(;? & Pine Needles
" 9] . . .
o & o Paints a trail of pine needles.
) 0y
® L
*m* "% 0 *D |
% % B @, Draws a line with a 3-D effect. ’
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o ﬁ F ® O Kaleidoscope effect. Perfect symmetry wherever you move the
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. o i :
O s %(tﬁg?j ' @ - \,’;}ﬂ
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@ Drippy Paint

Messy paint drips as you draw.

Connect-The-Dotsk

Make a connect-the-dots picture. Points are numbered as you
draw. When you release the mouse button, the line connecting
the dots disappears. Release the mouse button, then the Option
key.

* To keep the line between the dots, press the Option key while
you drag the mouse.

e To re-start the number sequence, click the Connect-the-dots
icon again.

* To space dots farther apart, click each dot into place
individually. When you do this, a connecting line will not
appear.

ABC

Alphabet Line*

The e. e. cammings effect. Paints with a line of alphabet letters
or with words of your own creation.

¢ To enter your own words, numbers or symbols, select
“Alphabet Text” from the Goodies menu or double-click the
icon. (Note: Double-clicking won’t work if you’re using Small
Kids Mode.) Type words or a new letter, number or symbol
sequence in the box that appears on the screen.

/
‘ﬁ“ Swirl

Lines swirl from the tip of the brush as you paint.

21
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Invert

This brush inverts the color of everything it passes over.
C TN
=
Ns#4

Produces random geometrical drawings. Click the mouse button
to start the drawing.

Geometry*

* To make a giant drawing, hold down the Option key as you
click.

* To stop before the drawing is finished, press the Command and
Period keys.

@ Treeskx

Generates “fractal” trees, each one different from the next. Click
the mouse button to start a tree.

* To make a giant tree with many branches hold down the
Option key as you click.

* To stop before the tree is finished, press the Command and
Period keys.

%g Caterpillars

Symmetrical caterpillars crawl around the screen.

e @
%.

The Jackson Pollock effect (or the cafeteria after a food fight).

Splatter Paint*

i

The Looper

Uh oh. Looks like the kitten’s gotten into the yarn.



Roll-The-Dice

Casts randomly numbered dice on your drawing,.

Picture Brushes

Paint with pictures.

*

X0

A

A Galaxy of Stars

Lots of Hugs and X’s

A Full Deck of Cards

Shapes and More Shapes

Electric
Mixer

Electric Mixer

Transforms your drawing in a variety of crazy, mixed-up ways.

To set mixer effects in motion, click the tool option you want,
then click on your drawing.

E Night and Day

Changes black to white and white to black. Inverts colors if
you’re using a color system. Click to make the change. Click
again to reverse it.

23
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Splash!

Big blobs of paint are splashed on your drawing. The longer you
hold the mouse button down, the more blobs appear.

H Checkerboard

Gives your drawing a checkerboard effect. Click to get the
transformation going. Click again to get your original drawing

back.

%g Wallpaperx

Makes multiple copies of a section of your drawing to create a
tiled, or wallpaper, effect. The pattern changes, depending on
what the pointer moves over.

* For smaller tiles, press the Option key as you click the mouse
button.

Venetian Blinds

Slices your drawing into horizontal stripes. Click repeatedly to
rearrange the pattern.

~
The Outliner

Outlines every line in your drawing. Click repeatedly to create a
series of fascinating effects.



Shadow Boxes

Copies sections of your drawing and places them in overlapping
boxes on the screen. Click repeatedly to produce more boxes.

u r* | ZoomliIn

Zooms in on a portion of your drawing, making it several times
larger. Click repeatedly to zoom in closer and closer.

E Broken Glass

Shatters your drawing into many jagged pieces.

W,
-)¢(-

Picture In A Picture

Shrinks a copy of your picture. Hold down the mouse button to
paste it anywhere.

| m The Highlighter

Highlights everything.

o
[4
23
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Pattern Maker

Turns your picture into a pattern.

U4
Lo

Wrap Around*

Wraps your picture around from one end of the screen to the




£

Snow flakes fall on your picture. * Hold down the Option key to
melt snowflakes into raindrops.

Snow Flakes And Rain Drops*

Paint
Can @ Paint Can*

Fills with the selected paint pattern.
Eraser

J Erasers

Lets you erase all or part of your drawing in a variety of
interesting ways.

e

Erasers range from large to small. Choose whichever size or
shape you need to get the job done.

Eraser sizes

N7
9=
.ﬁ\

Clear the screen in one big blast. Select this option, then click on
your drawing to start the explosive reaction.
* To Freeze the Firecracker effect, press the Option key.

Firecrackerx

&)
h-4 Hidden Pictures
Kid Pix has secrets. Uncover hidden pictures by selecting this

option and erasing. To uncover another hidden picture, click the
option again and continue to erase.



O
O White Circles

Big white circles gobble up your drawing. Hold down the mouse
button until everything’s gone.

€>

Slip-Sliding Away*

Sliding doors erase your drawing.

C

#$%!* 1%

An exclamatory end to it all!

% | Fade Awayx

Watch your picture fade away.

¥ | Drop Out*

Chunks of your picture drop out until nothing is left.

” * 1 Black Hole

The black hole swallows up everything!

@

Count down to today's date and time

Count Down

27
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Spins and sweeps your picture away.

Sweep*x

Text

A Textx

Place letters, numbers, and symbols wherever you want on your
drawing. When you select a letter a voice speaks its name in
English or in Spanish. Click to stamp the letter you’ve selected in
place on your drawing. If one letter is stamped close to another,
it will align itself to the baseline of the previously placed letter.
You can also enter text from the keyboard.

* To turn off the baseline feature, press the Option key as you
stamp the letter in place.

* To enter text from the keyboard, press the Option key as you
select the Text tool. Position the pointer where you want the text
to appear on your drawing. Then type in the text you want.

* To change all menu text to Spanish and select the Spanish-
speaking alphabet, choose "Switch to Spanish" from the Goodies
menu.

28

Rubber Stamps*

Place “rubber stamp” pictures on your drawing. Eight sets of
rubber stamps are available. Stamps are multi-colored if you are
using a color system. Click to stamp the picture you’ve selected
in place. To place many rubber stamp pictures on your drawing,
hold the mouse button down and move the mouse.

* To double the size of a stamp, press the Option key while
stamping the picture in place.

e To triple the size of a stamp, press the Shift key while stamping
the picture in place.

e For gargantuan stamps, press both the Option key and the Shift
key while stamping the picture in place.

Note: Gargantuan stamps won't work on 9" monochrome
monitors.



* To edit or add new stamps, use the “Edit Stamp” option on the
Goodies menu. Or simply double-click the Rubber Stamp icon.
(Note: Double-clicking won’t work if you are using Small Kids
Mode).

2
Moving Vanx

Moves a selected section of your drawing from one spot to
another. Choose the size and shape “moving van” you need.
Position the van over the section you want to move. Move the
section by holding the mouse button down and moving the
mouse. Release the button when the section is where you want it
to be.

int: Move your mouse slowly to make a stamp brush.

* To move a copy of the selected section, hold the Option key
down while you move the mouse.

The | BB | option gives you an adjustable-size moving van that
you can use to capture and move any section of the drawing you
want. You can also cut, copy, clear, or paste the captured
section, using the commands on the Edit menu.

* To capture a section, select the L@_} option. Then position the
cross-shaped pointer at the upper-left corner of the section you
want. Hold the mouse button down and move the mouse until
the section is captured. Release the mouse button.

* To move the captured section, hold the the mouse button down
and move the mouse. Release the button when the section is
where you want it to be.

* To apply editing commands to the captured section, open the
Edit menu and choose the command you want.

The
Undo &y
Guy The Undo Guy

A friend in need. The handy Undo Guy comes to your rescue
whenever you do something you didn’t want to do. Click his
anxious face and the results of your last action will immediately
disappear. (Works the same as “Undo” on the Edit menu.)
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About
Kid Pix
Menus

Kid Pix menus include standard Macintosh features. The File
menu allows you to open files, close files, save your work, print,
and quit the program; the Edit menu allows you to perform basic
editing functions. If you’re not very familiar with the Macintosh,
you may want to consult your Macintosh manual for a complete
discussion of how the menus work.

* To open a menu, point to the menu you want and hold the
mouse button down.

* To choose a menu item, move the mouse until the option you
want is highlighted; then release the mouse button.

File
Menu

E New 3N

Lets you start a new Kid Pix file. Starting a new file is like
getting a clean sheet of drawing paper. You will be given a
chance to save changes to your current drawing before the new
file is opened.

Lets you open a previously saved Kid Pix file. Select the file you
want from the list on the screen. If the file has a recorded sound
message attached, you’ll be given the option of opening it
without the sound.

Close WU

Lets you close the current file.
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Save S

Lets you save a drawing. If the drawing has a recorded sound
message attached, you’ll be given the option of saving it without
the sound.

g& Save fis...

Lets you save the current drawing with a different name. If the
drawing has a recorded sound message attached, you’ll be given
the option of saving it without the sound.

% Page Setup...

Lets you set page size, orientation, and other print options. For
best results select the “Tall Adjusted” feature.

Print... %P

Lets you print out your drawing.

-

" Quit %0

Lets you leave the program. You will be given a chance to save
changes to the current drawing before you quit.

Edit
Menu
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Undo 32

Undoes your last action.

X Cut 38H

Lets you cut a captured section from your drawing and place it

on the Clipboard. Use the | f} | option under the Moving Van

tool to capture the section.



Eg Copy $8C

Lets you copy a captured section of your drawing to the
Clipboard. Use the option key under the Moving Van tool to
capture the section.

@ Paste 38D

Lets you paste whatever is on the Clipboard onto your drawing.

When you choose “Paste” whatever is on the Clipboard will
appear on your drawing along with a pointer shaped like a paste
jar. Move the mouse without holding down the mouse button
until the Clipboard selection is where you want it to be. Click
the mouse button to paste the selection in place.

@'“) Clear

Lets you remove a captured section from your drawing. Use the
option under the Moving Van tool to capture the section. The
cleared section will not be placed on the Clipboard. To get it
back, choose Undo before you do anything else.
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Small Kids Mode 3K

Lets you turn off the full menu bar. Places a “bib” around the
screen so that background applications cannot be accidentally
opened.

This feature is handy when younger children use Kid Pix. It
eliminates the problem of a child straying into another
application or accidentally opening a menu, selecting an item,
and getting stuck in a situation — such as an editing or dialog
box — that he or she may not know how to handle.

When you choose “Small Kids Mode” a special menu bar that
looks like this will appear:

@ | Kid Pin ]
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e To temporarily view and select items from the full menu bar,
choose “Show Menu Bar.” The full menu bar will disappear
when drawing is resumed.

e To turn off the Small Kids Mode and restore the full menu bar,
simply choose “Small Kids Mode” from the Goodies menu
again. You will need to do this in order to open or save a file or
quit the program.

& Edit Stamp... 38E

Lets you edit the “rubber stamp™ pictures contained in Kid Pix.
You can even create an entirely new stamp from scratch. To edit
a stamp:

e Select the Rubber Stamp tool.
e Click the stamp you want to edit.

e Choose “Edit Stamp” from the Goodies menu or simply double
click the stamp. (Note: Double-clicking won’t work if you are
using Small Kids Mode.) The Stamp Editor will appear.

Stamp Editor = |

[+
\ 4

[Estore l]rigirm
F Cancel J

The current stamp is displayed in an enlarged version in the
editing box. It is made up of many small squares called pixels.
An actual-size version of the stamp appears in the upper-right
corner of the Editor. Editing tools and the color palette (if you
are using a color system) are displayed to the left of the editing
box; control buttons are to the right.




To edit the stamp:

e Click the pixels you want to change. Black pixels change to
white; white to black.

If you are using a color system, clicking a pixel will change it to
the current color; if it is already in the current color, clicking will
change it to white.

e Use the editing tools and control buttons as needed.

ha

Rotates stamp 90 degrees

Rotate

-

Flip

Flips the stamp from left to right and right to left.

Undo

Undoes your last action.

ﬂ Clear

Clears the stamp from the Stamp Editor. Use this tool if you
want to create an entirely new stamp from scratch.

(Don’t worry about losing the original stamp. The program
always keeps a copy. You can get the original back whenever
you want by clicking the Restore Original button.)

Color Palette

Works just like the color palette you use when creating a Kid Pix
drawing.

Note: To select a color from the stamp itself (rather than the
palette) hold down the Option key and click on an area of the
stamp that contains the color you want.
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Restore Original
Restores the original Kid Pix stamp.

On quitting Kid Pix, the program will ask you if you would like
to save your stamps. But Kid Pix always keeps a copy of the
original stamp which you can restore at any time by clicking this
button.

Cancel

Returns you to the Kid Pix drawing screen without saving
changes you have made to the stamp.

OK

Saves changes you have made to the stamp and returns you to
the Kid Pix drawing screen.

Alphabet Text... %A

Lets you enter new letters, numbers or symbols for the Wacky
Brush Alphabet Line.

When you select “Alphabet Text” a text entry box will appear.

Enter new letters

ABCDEFGHIJKLMNOPQRSTUDIIRYZ

» To enter new text, simply type in the letters, numbers, or
symbols you want. No need to press Return at the end of a line.
The text will cycle automatically from line to line. If you make a
mistake, use the Backspace key to move the cursor to the left and
then type in your correction.



e Click the OK button to save your text and return to the Kid Pix
drawing screen.

e Click the Cancel button to restore the original text and return
to the drawing screen.

")) Tool Sounds

Lets you turn off Kid Pix sound effects. To turn tool sounds
back on, simply select “Tool Sounds™ again.

& Record Sound #R

Lets you record a voice or other sound message (music, special
sound effects, a poem or story) to accompany your drawing.
You can save the drawing with or without the sound message
attached.

The record feature is available if you are using Kid Pix with the
Macintosh IIsi or Macintosh LC; or if you have Farallon's
MacRecorder® and System 6.0.7 installed on your Macintosh.

To record a message, choose “Record” from the Goodies menu.
The Sound Input dialogue box will appear.

e When you’re ready to start recording, click the Record button.
Speak into the microphone. The seconds bar shows how much
time has elapsed. If you want to pause, click the Pause button.
Click the Record button to start recording again.

@ i <
Record Stop Pause Play

| ] :00 Laep
- = [ Soue

seconds

* When you’re done recording, click the Stop button. To play
back your recording, click the Play button. If you’re not satisfied
with your message, click the Record button and do it over.

e When you’re satisfied with your recording, click Save. The
sound message will be attached to your drawing. When you are
ready to Save the drawing to disk, you’ll be given the option of
saving it without the sound message if you wish.
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??\i Play Sound 3&H

Lets you play a recorded message attached to a drawing. To play
the message, simply choose “Play” from the Goodies menu. If
no message has been attached to the drawing, “Play” will be
grayed out. To interrupt a long recording and begin drawing,
press the Command and Period keys, or press the mouse button.
To speed up the sound, press the Option key. To slow down the
sound, press the Space bar.

Pt
n Switch to Spanish

Lets you switch between Spanish and English talking alphabets,
menus and help. Select once to switch to Spanish; select again to
switch to English.

More
About
Sound
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Sound can only be recorded in Kid Pix if you are using the
Macintosh IIsi, Macintosh LC or Farallon's MacRecorder® and
System 6.0.7 or higher. System 6.0.7 is also required for playing
back sounds.

Note: Sounds recorded and saved with Kid Pix on the Macintosh
11 series of computers cannot be played back on the Macintosh
Plus, Macintosh SE, or Classic.

The MacRecorder Sound System is the complete sound editing
package for the Macintosh. It is well suited for sound editing,
multimedia presentations, HyperCard use, and music
applications. The MacRecorder Sound System has been shipping
since January 1988 and is considered a standard for recording.

For more information, please write or call Farallon Computing,
2000 Powell Street, Suite #600, Emeryville, CA 94608.

PLEASE DO NOT MAKE ILLEGAL COPIES OF THIS SOFTWARE

The software you are using was produced through the efforts of many people: designers, artists,
programmers, distributors, retailers and other dedicated workers.

The costs of developing this and other software programs are recovered through software sales. The
unauthorized duplication of personal computer software raises the cost to all legitimate users.

This software is protected by federal copyright law. Copying software for any reason other than to make
a backup is a violation of law. Individuals who make unauthorized copies of software may be subject to
civil and criminal penalties.

Broderbund Software, Inc.
as a member of the Software Publishers Association (SPA) supports the industry’s effort to fight the illegal
copying of personal computer software.

Report copyright violation to:
SPA, 1101 Connecticutr Avenue, NW, Suite 901
Washington, D.C. 20036
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Kid
P1x
Notes

My Stamps

A file called "My Stamps" is created the first time you use Kid
Pix. "My Stamps" is your personal version of the Kid Pix
Rubber Stamps. Any editing that you do to Kid Pix stamps is
saved in "My Stamps".

Bigger Color Cells

To make the colors bigger in the color palette, go to the Control
Panel and set your monitor to "16 colors." Small children may
find large colors easier to click on.

About Kid Pix,
System 7.0 or
Multifinder
and Memory:

Kid Pix requires far less memory when running on a Macintosh
Plus, SE, SE 30, or Classic with their 9 inch monochrome screens
than it does when running in 8 bit color on a Mac II with its
standard monitor.

Multifinder and System 7.0 require that a program specify how
much memory it needs so that it can allocate a partition for it. By
default Kid Pix is set to require enough memeory to run on a
color system. This is much more memory than it needs to run on
a small screen monochrome system.

To run Kid Pix under Multifinder or System 7.0 on a small
monochrome screen, and to make the most efficient use of
memory, follow these steps.

1. At the Finder, select Kid Pix by clicking on it once.
2. Go to the File menu and select Get Info.

3. Change the number in the Application Memory Size box to
800 and close the box.

Kid Pix and
Monitors

42

Press the spacebar when booting Kid Pix and the drawing
screen will enlarge to take advantage of monitors larger than

an
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KID PIX ON A DIET 1) Make backup copies:

Installing Kid Pix on Two Putting Kid Pix on a diet is a permanent process. It should

800k Drives only be done on backup copies. Store your original disks in a
safe place and use the copies to create your working set of
Kid Pix disks.

2) Create a start-up disk:
The start-up disk is the disk that contains your System Folder.
Use the “minimal software for Macintosh Plus” option in the
Macintosh Installer program to create a System Folder that
requires less disk space.

e Copy your printer driver and MacRecorder driver (if you
have a MacRecorder) into the System Folder on the start-up
disk.

* Copy the “Sounds” file from Disk 2 (Bonus Sounds) into the
System Folder on your start-up disk. You now have a
completed start-up disk.

3) Put Kid Pix on a diet:

e Insert the start-up disk in the internal drive.

e Insert your working copy of Disk 1 (Program) into
the external drive.

® Turn on the computer

e Double-click the Kid Pix program icon and hold down the
#-D keys.

e A dialogue box will appear asking if you would like to put
Kid Pix on a diet. Click on “Diet.”

* You will be returned to the Finder when the diet process is
complete.

4) Copy an Alphabet onto Disk 1 (Program):
 Copy ecither “English Alphabet” or “Spanish Alphabet” from
your working copy of Disk 2 (Bonus Sounds) onto Disk 1
(Program).

Note: The Kid Pix Alphabet will “speak” in whichever language
alphabet resides on Disk 1 (Program).

5) Your Program disk is now complete, double-click on the
Kid Pix program icon to begin.

Note: If one of your drives is a SuperDrive (1.4 Mb), you will
not need to put Kid Pix on a diet. Both Kid Pix and an
Alphabet will fit on the same high-density disk. 43
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Brederbund’s Limited Ninety-Day Warranty

Broderbund warrants for a period of ninety (90) days following the original retail
purchase of this copy of Kid Pix that the program is free from substantial errors or
defects that will materially interfere with the operation of the program as described
in the enclosed user documentation. This policy applies to the initial purchaser only.

If you believe you have found any such error or defect in the program during the
warranty period, call Brederbund’s Technical Support Department at 415/492-3500
between the hours of 8 a.m. and § p.m. (Pacific Time), Monday through Friday.
Brederbund technical personnel will attempt to help you correct or avoid the
problem. If any such error or defect cannot be corrected or reasonably avoided,
Broderbund will inform you how to obtain a corrected program disk (or, at
Broderbund’s option, Braderbund may authorize a refund of your purchase price).

This warranty gives you specific legal rights, and you may also have rights which
vary from state to state.

Disk Replacement Policy

If any disk supplied with this product fails within ninety (90) days of purchase for
any reason other than accident or misuse, please return the defective disk together
with a dated proof of purchase to Brederbund Software-Direct®, 17 Paul Drive, San
Rafael, CA 94903-2101, for a free replacement. This policy applies to the original
purchaser only.

Broderbund will replace program disks damaged for any reason, whether during or
after the ninety (90) day free replacement period, for $5 per disk plus a postage and
handling charge of $2.50 per request, as long as the program is still being
manufactured by Brederbund.

Limitations on Warranty

Unauthorized representations: Broederbund warrants only that the program will perform as
described in the user documentation. No other advertising, description or representation,
whether made by a Brederbund dealer, distributor, agent or employee, shall be binding upon
Broderbund or shall change the terms of this warranty.

Implied warranties limited: Except as stated above, Broderbund makes no other warranty,
express or implied, regarding this product. Brederbund disclaims any warranty that the
software is fit for a particular purpose, and any implied warranty of merchantability shall be
limited to the ninety (90) day duration of this limited express warranty and is otherwise
expressly and specifically disclaimed. Some states do not allow limitations on how long an
implied warranty lasts, so the above limitation may not apply to you.

No consequential damages: Braderbund shall not be liable for special, incidental, consequential
or other damages, even if Broderbund is advised of or aware of the possibility of such damages.
This means that Broderbund shall not be responsible or liable for lost profits or revenues, or
for damages or costs incurred as a result of loss of time, data or use of the software, or from
any other cause except the actual cost of the product. In no event shall Braderbund’s liability
exceed the purchase price of this product. Some states do not allow the exclusion or limitation
of incidental or consequential damages, so the above limitation or exclusion may not apply to
you.

You are entitled to use this product for your own use, but may not sell or transfer
reproductions of the software or manual to other parties in any way, nor rent or lease the
product to others without the prior written permission of Brederbund. You may use one copy
of the product on a single terminal connected to a single computer. You may not network the
product or otherwise use it on more than one computer or computer terminal at the same time.

For technical support, on this or any other Brederbund product, call
415/492-3500.
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For more information about Braderbund Software and our products, write fo us of 17 Paul Drive, San Rafael, California 94903-2101. 2805510




